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本文档包含此版本中已修复问题的错误编号及相应说明。此外，本文档可能还包含此版本中新增

功能的相关信息（如果适用）。强烈建议您安装此版本前阅读本文档。为便于参考，应该将本自

述文件保存到硬盘驱动器或打印一份副本。 

重要说明： 

 此版本在所有操作系统上均为完整产品安装。因此在安装此版本之前，请先卸载现有 

Maya 应用程序。 

 此版本包含之前 Service Pack 版本中提供的所有修复。因此，除了此扩展外，无需下载

和安装所有之前的版本。 
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其他资源 

有关卸载和安装此版本的完整说明，请参见：www.autodesk.com/maya-install-2013-chs。 

有关完整文档和学习资源的信息，请参见：www.autodesk.com/maya-docs。 

有关硬件限定条件的信息，请参见：www.autodesk.com/maya-hardware。 

若要报告此版本相关的问题，请参见：www.autodesk.com.cn/maya-support。 

有关更多资源的信息，请参见：www.autodesk.com/maya-learningpath。 

新功能 

有关此版本中引进的新功能信息，请参见 Maya 帮助：

http://download.autodesk.com/global/docs/maya2013/zh_cn/。 

 

修复了什么？ 

本节介绍此扩展所提供的修复。 

Autodesk Maya 2013 Extension 自述文件 

http://www.autodesk.com/maya-install-2013-chs
http://www.autodesk.com/maya-docs
http://www.autodesk.com/maya-hardware
http://www.autodesk.com/maya-support
http://www.autodesk.com/maya-learningpath
http://download.autodesk.com/global/docs/maya2013/zh_cn/
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如需之前版本所提供修复的列表，请参见：

http://images.autodesk.com/adsk/files/Maya2013_SP1Readme_CHS0.pdf。 

动画 

错误编号 说明  

MAYA-1423 Create a new animation layer when HIK skeleton is baked onto new layer 

MAYA-1492 Fix usage of skinCluster -skinPercent flag 

MAYA-4376 Shoulder rig using default Maya nodes doesn't evaluate correctly  

MAYA-8962 Speed up loading of some scenes with IK 

MAYA-11052 Use specified rotation order when manipulating HIK effectors in “World” mode 

MAYA-11175 Correctly blend quaternion rotations in animation layers 

MAYA-11428 HIK offsets introduced while manipulating body parts 

MAYA-11480 HIK IK Effectors not updating properly when an auxiliary effector exists 

MAYA-11537 Address manipulation rotation glitches on aligned rig 

MAYA-11796 HIK auxiliary effectors at wrong position when rig is out of sync 

MAYA-12151 Character set interferes with getAttr -t command 

MAYA-12235 Update default extension of weight map import filter to “.weightMap” 

MAYA-12417 Don’t change HIK effector visibility when undoing manipulation 

MAYA-12861 Avoid crash when deleting referenced constraints 

MAYA-12943 Sync rig on set key in full body/body part modes 

MAYA-13309 
Rotation HIK shoulder FK effector in body part mode affects the rig in full body 
mode 

MAYA-15105 Animation layers: add selected reference not working 

MAYA-15670 skinCluster influences are shown in a different order from previous version 

MAYA-155 Don’t create keyframes at current time during certain undo operations 

MAYA-792 Speed up fat connections 

MAYA-1260 
Make sure Playblast can handle multiple decimals (i.e., “.”) in the target 
filename 

MAYA-3127 Store stroke values when painting blend shapes with reflection 

MAYA-3149 Use hotkeys to advance frame in the graph editor 

MAYA-5115 Use consistent extensions when handling JPEG images 

MAYA-6032 Turn “Auto Joint Orient” option on move tool off by default 

MAYA-6155 Fix sequencer Playblast that causes image plane results to be off by one frame 

MAYA-8111 Address animCurve performance 

MAYA-10349 Avoid crashes when handling scaled keys in the graph editor 

MAYA-11099 Ensure getAttr -time returns correct value 

MAYA-11430 Avoid resetting key values to zero when using “Show Buffer Curves” 

MAYA-11545 Allow user-level control of plug-in shapes visibility in modelEditor and Playblast 

MAYA-11832 Ensure values persist if keys are deleted 

MAYA-12317 
Ensure copy vertex weights handles scenes with nodes that have the same 
name 

MAYA-12663 Correctly animate locators during playback and timeline scrubbing 

MAYA-13424 Ensure MMB and LMB have the same behavior for local constrained moves 

MAYA-14511 Avoid crash when hammering skin weights 

MAYA-14761 
Avoid crash when deleting keys in the graph editor and pre-select highlight is 
enabled 

MAYA-3055 Correctly handle the –sequenceTime flag during Playblast 

http://images.autodesk.com/adsk/files/Maya2013_SP1Readme_CHS0.pdf
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错误编号 说明  

MAYA-3119 Avoid skipping non integer frame when stepping over timeline 

MAYA-6055 
Avoid duplicate dialog prompts when exporting an animation clip over an 
existing file 

MAYA-8291 Allow users to attach image plane using context menu 

MAYA-10171 
Avoid displaying incorrect warnings about stereo cameras when using the 
sequencer 

MAYA-12176 Referenced object on animLayer cannot be removed from AnimLayer 

MAYA-12513 
Expand time range that can be used in Trax and Sequencer from +/-100K to  +/- 
8M 

API 

错误编号 说明  

MAYA-3180 There is no kFloatArray type for MFnData 

MAYA-6413 Duplicate MPxLocator nodes do not inherit the value of the visibility attribute 

MAYA-7897 Context tool with custom cursor doesn't work  

MAYA-10808 Extra semicolon in MFnBase.h generates spurious warning messages 

MAYA-11162 Extra semi-colon in MThreadUtils.h 

MAYA-11192 Using switch-case to implement operator[] in MVector.h and MFloatVector.h 

MAYA-11399 
Unable to attach 'transferAttributes' node object to MFnGeometryFilter function 
set 

MAYA-11715 Typo in MFileIO.h 

MAYA-11720 Getting Maya Library to run as a process 

MAYA-11734 MItDependencyGraph::getPlugPath returns path in reverse order 

MAYA-13871 blastCmd.cpp aspect ratio trouble when using fbo offscreen functions 

MAYA-15057 getApplicationVersionAsFloat() can incorrectly return 0 in certain situations  

Artisan 

错误编号 说明  

MAYA-6518 Paint Attributes Tool is not remembering last setting 

MAYA-15219 Object 'exportMapValueMenu' not found and artisan tools become corrupt 

Composite 

错误编号 说明  

MAYA-1266 Overlay mode in Reaction renders incorrectly 

MAYA-1298 Correct conflicting file and directory permissions  

MAYA-9364 Color picker does not show correct luminance values for over bright pixels 

MAYA-13047 Gamma conversion on render output doesn't work 

文件引用和文件 I/O 

错误编号 说明  

MAYA-8901 Too slow to open scene with reference instancing 

MAYA-14572 
Removing a referenced object that constrains another referenced object causes 
crash 

MAYA-15297 Crash when performing a Reference Remove 

MAYA-4502 Object’s full DAG path not used when applying a reference edit; edits applied to 
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错误编号 说明  

incorrect object 

MAYA-6459 Reference Edits not saved in a callback 

MAYA-8245 Avoid crashes on file load with large scene due to memory handling 

MAYA-10445 referenceQuery liveEdits query does not return full DAG path to nodes 

MAYA-1810 Scene file crashes Maya instantly  

MAYA-9540 addAttr category not saved on File > Save 

MAYA-12812 
Creating an itemFilter with non-default classification causes a CER when 
exporting all with preserve reference checked on 

MAYA-15099 Crash with export selection 

MAYA-15966 Maya fails to open a newer binary file with ignore version turned on 

MAYA-14932 Crash when listing unloaded references 

流体 

错误编号 说明  

MAYA-10338 Maya Fluids Auto Resize Bounding slow 

MAYA-10647 Incorrect rendering with mental ray (ocean changes levels every other frame) 

MAYA-12093 Fluid emission direction wrong when fluid is rotated 

建模 

错误编号 说明  

MAYA-122 Display Alpha as Grey scale does not work in Viewport 2.0 

MAYA-774 Bad Display After cut-and-move 

MAYA-1478 Merge to Center creates history when history is disabled 

MAYA-6541 Crash when selecting vertices on Lion (10.7.2) followed by hitting the spacebar  

MAYA-9485 Interactive polygon split tool will stop unexpectedly on non-manifold geometry 

MAYA-10467 
General sets membership propagation behavior differs from ShadingEngine 
sets after polyUnite (Mesh > Combine) 

MAYA-10470 
Component set membership not propagated with certain poly operations 
(polyUnite, polyBoolOp, polySeparate) 

MAYA-10553 
ColorSets not correctly propagated for polySmooth(exponential), polySeparate, 
polyUnite, polyPoke(triangles), and polyDelEdge(invalidGeom) 

MAYA-11679 
Edit Curves > Rebuild (performRebuildCurveSet.mel script) errors when the 
curve shape is non-unique 

MAYA-11787 Merge UV doesn't work on non-default UV set 

MAYA-12125 When all Falloff Curves are set to 1, flooding soft-mod weights on vertices fail 

MAYA-12603 
polyMirrorFace and polyChipOff actions do not propagate objectSet 
membership for edges and vertices as expected 

MAYA-13141 Pressing '3' for polygon mesh causes custom viewport crash 

MAYA-14085 
RelationshipEditor only acts on "objectSet" and "character" nodetypes, and not 
nodes derived from objectSet 

MAYA-14763 polyChipOff & keepFacesTogether when set to False causes crash 

MAYA-15445 polyQueryBlindData does not return expected value after importing other object  

MAYA-15446 
polyQueryBlindData does not return expected value after selecting UV set as 
current  
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Viewport2.0 

错误编号 说明  

MAYA-964 When selecting a duplicated object the unselected object gets display priority 

MAYA-1129 Material with texture project node doesn't render 

MAYA-6203 Camera override with orthographic matrix is incorrect 

MAYA-6617 Face index number has black backgrounds behind it 

MAYA-6865 Component IDs cannot be drawn on Mac 

MAYA-8208 Crash when rendering with high res settings 

MAYA-8893 DX11 effect using a geometry shader does not render, does not throw errors 

MAYA-9404 NURBS surface scene is very slow to load and update  

MAYA-9569 
DX11Shader Time and FrameNumber semantic does not provide any 
meaningful data 

MAYA-9702 Undoing a mental ray Batch Bake causes crash 

MAYA-10096 Camera scale locator doesn't update 

MAYA-10368 Joint axis do not scale to screen space 

MAYA-11024 Add support for clamp color shading node 

MAYA-11317 normalMaps not displayed as expected 

MAYA-11895 Extend MGeometryExtractor to support more than just polygonal meshes 

MAYA-12626 Painting vertex color works with per instance sharing incorrectly 

MAYA-12632 Unparenting objects from hidden parent causes corruption 

MAYA-12847 
Camera Based Selection not working for Marquee and Drag select on second 
selection (depth test state bleed) 

MAYA-13175 Crash when using custom override 

MAYA-13804 Crash when performing multiple Undo operations to CGFx Shader modifications 

MAYA-13836 Masking textures with blending does not work correctly 

MAYA-14364 Image plane not updated properly if camera parameters are changed 

MAYA-14388 Transparent objects are handled incorrectly 

MAYA-14749 Crash when deleting resources from plug-ins 

MAYA-15977 Face center doesn’t display 

渲染 

错误编号 说明  

MAYA-142 
Crash when attaching Checker texture node to the Frequency ratio of the Noise 
node 

MAYA-11377 Allow PTex slice to link tools with an independent version of the PTex library 

MAYA-11903 
Crash on save (possibly due to switching the connection on cameraShape 
node) 

MAYA-12409 Alpha value of float texture image are changed by HDR image preview options 

MAYA-12885 Crash when tearing off a stereo panel a second time 

MAYA-13177 Support second UV sets in MGeometryExtractor implementation 

MAYA-13207 HLSL plug-in does not support the standard set of annotations and semantics 

MAYA-13329 Crash in TpolyHwConverter when interactively moving UVs 

MAYA-3163 Light intensity changes when photometric light's transform is scaled 

MAYA-11530 Transparency set to 1.0 when using the mia_material 'Chrome' Preset 

MAYA-14019 
mia_photometric_light casts light incorrectly depending on the "shape" of the 
mental ray Area Light 
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脚本 

错误编号 说明  

MAYA-11638 Group MEL command does not return unique name 

MAYA-11850 Error when exiting in standalone mode when using the PyMEL  

MAYA-14620 shelfButton default pop-up menu is unexpectedly attached to another control 

MAYA-3256 Parenting script slowdown 

MAYA-4526 Python script slowdown 

MAYA-8247 Python confirmDialog fails silently when invalid flag used 

MAYA-9103 Performance issues with TnameObject::reserveName 

MAYA-13370 Python File command pr flag causes crash 

MAYA-13767 PyMEL version "ls" command, "-long" is ignored 

Maya 一般功能 

错误编号 说明  

MAYA-9321 Crash when custom node calls a MEL command and the undo limit is reached 

MAYA-10148 Channel Box can't cancel editing value by Esc key 

MAYA-10396 Window -widthHeight/-width/-height flag doesn't work 

MAYA-10703 4Double types not saved or read in .ma format 

MAYA-10810 Error with cmds.objectTypeUI for new windows 

MAYA-10916 Crash when doing hotbox gestures with RMB 

MAYA-11194 Component editor: unexpected data entry when Ctrl+LMB click 

MAYA-11334 
Expand Spreadsheet Checkbox in animcurve Attribute Editor template 
inconsistencies 

MAYA-11603 Spacebar can be used to switch views during a mouse operation 

MAYA-11630 Flag -byName in selectType and selectPriority should be split into two flags 

MAYA-11718 Editing a shelfButton causes popup menu to attach to incorrect UI 

MAYA-11822 Undo in Script Editor no longer works with the clear history buttons 

MAYA-11823 xform command does not support -ws -s in query mode 

MAYA-11856 TnamespaceManager::isAbsoluteName() optimizations 

MAYA-11980 Shift+Drag files into viewport will delete them (Windows only) 

MAYA-12209 channelBox fieldWidth cannot be changed 

MAYA-12260 File > Open dialog slow with networked machines 

MAYA-12380 Marking menu items with submenus can't be highlighted  

MAYA-12384 
Crash on close (‘x’ button) and Save, shutdown on cancel after crash is 
removed 

MAYA-12558 RGB overlay performance issues  

MAYA-12919 
Expose stack tracing into TdbTrace (dbtrace) framework and add printStack() 
option 

MAYA-12937 
editorTemplate with -addDynamicControl creates empty space in Attribute 
Editor 

MAYA-13922 Heads up display buttons not visible 

MAYA-14092 PolyTextureMenu.mel repeated arguments 

MAYA-146 Stereo camera viewport breaks when tearing off and saving display state 

MAYA-14864 Querying the objectTypeUI 'listAll' argument is broken  

MAYA-14943 Hypershade Create Bar defaults to half the width of the Hypershade 

MAYA-15142 ChannelBox ‘Duplicate Values’ limited to work with only one object 

MAYA-15271 dgInfo tells does not include information about connections 
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错误编号 说明  

MAYA-15533 Copying 256K of text from the History in the Script Editor fails on Linux 

MAYA-1774 
Custom hotkeys not respected and connection lost on mapping of former 
press/release hotkeys (if hotkeys saved and Hotkey Editor is open) 

MAYA-1838 Channel Box selection cleared when selecting a key in the Graph Editor 

MAYA-1975 Marking menus slower with fast gestures 

MAYA-3262 qdockwidget problems 

MAYA-3288 Deleting a shelf present at start-up returns an error 

MAYA-5991 Scale tool not aligning when an object is rotated 

MAYA-6141 Switching between Attribute Editor and Channel Box is not predictable 

MAYA-6350 
Quotes and backslashes in render or animation layers break the functionality 
and cause data loss 

MAYA-7566 Crash when opening file browser while animation is playing 

MAYA-7665 Error with setParent command 

MAYA-8530 Crash when the attrcolor flag is used 

MAYA-8615 Add floating point Hue value for the new Color Chooser 

MAYA-9381 Imageplane attributes not always accessible 

MAYA-9436 
File Browser can render thumbnails for "jpg", "png", "bmp" and "tif", but not 
"JPG", "PNG", "BMP" and "TIF" (case sensitive) 

MAYA-9940 Prevent use of Shift key from causing focus issues in the Node Editor 

MAYA-2068 License error causes performance slowness 

MAYA-11573 Send To feature missing 

MAYA-890 DWG_DCE export from command line crashes Maya 

MAYA-10854 Optimize TobjImport::cleanupMesh()  

MAYA-10736 Incorrect particle motion blur at emission with mental ray 

MAYA-12128 Reposition using middle mouse button doesn't work with Rotate Tool 

MAYA-11023 Upgrade Alembic Libraries and Plugins to 1.0.5 

MAYA-9670 NVidia Quadro Gfx Driver bug: Maya crashes when gpuCache imports abc files 

 

功能限制和说明 

以下部分介绍有关此版本的限制和其他说明。 

限制 

错误编号 说明  

MAYA-11471 
Undo after deleting a Scene representation from an assembly definition causes 
node not to work properly 

MAYA-12661 Cannot reload Scene Assembly file after changing render layer order in that file 

MAYA-12934 assemblyReference node can use invalid character for namespace (e.g. ‘1’) 

MAYA-13492 
Opening files with saved Scene Assembly edits always indicate that unsaved 
changes have been made 

MAYA-16009 Cannot undo removal of Scene Assembly edits 

MAYA-16354 
Edits to lattice points or curve CVs on objects contained in a Scene Assembly 
hierarchy do not display in the List Assembly Edits window 

Maya-16444 Relative file paths display as absolute file paths in the Attribute Editor 

Maya-16049 Transform values on assemblyDefinition nodes are not saved as edits 
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错误编号 说明  

MAYA-1475 Subdivision surfaces face selection is not visible in Viewport 2.0.  

MAYA-15567 

In Viewport 2.0, when the fall-off radius of the Soft Modification Tool is so small 
that it can only affect some control points but not edit points, then false coloring 
may not appear.  

说明 

MAYA-1436：使用到其他软件的一键式功能时本地化默认文件名称崩溃 

如果默认场景名称是简体中文或日语字符的“Untitled”，在执行到其他软件的一键式功能时可能会

发生崩溃。若要避免此问题，请仅以单字节 ASCII 字符重命名该场景，然后再通过 ICE 发送至其

他产品。 

MAYA-9651：非字母拼写的 Shift 热键不能与 Ctrl 修改键配合使用 

非字母拼写的 Shift 热键不能与 Ctrl 修改键配合使用。例如，“CTRL+]”可以作为热键正常使用，

但“CTRL+}”（实际代表的是“CTRL+SHIFT+]”）不行。 

MAYA-11993：某些重影的线框上色错误 

Viewport 2.0 中的渲染顺序与其他视口中不同；因此，相同的对象可能会以不同的顺序绘制，并

可能在另一个对象的上部绘制。“动画层重影”通常会出现这种情况。 

MAYA-16277：用于 Viewport 2.0 中与 DX 设备配合使用的调试模式环境变量 

此环境变量可用于在开发 Viewport 2.0 插件时调试显卡问题。您必须安装 DirectX SDK 才能使用

此功能。将 MAYA_FORCE_DX_DEBUG_DEVICE 设置为 1 后，在 Viewport 2.0 中使用 

DirectX 模式，DirectX 设备创建时 D3D11_CREATE_DEVICE_DEBUG 标志处于启用状态。 

GPU 缓存：Maya 随附的 HDF5 库非线程安全 

Maya 随附的 HDF5 库不是线程安全的（使用 --disable-threadsafe 编译）。 

但是，分析显示非线程安全的 HDF5 的性能优于线程安全版本。由于 Maya 当前以单线程的方式

调用 Alembic，所以可安全使用。 

MAYA-14706：使用图像平面序列的固定图像平面在 Viewport 2.0 中加载速度很慢 

将附加的图像平面从使用图像序列切换回使用单个图像时，对时间轴的约束没有移除。因此，图

像要重新加载每一帧。 

解决方案：通过断开与“图像编号”(Image Number)字段连接的表达式删除该约束。 
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MAYA-16289 由负缩放引起的背面多边形在 Viewport 2.0 中变为黑色 

当 DirectX 11 Shader 属性编辑器下的“双面照明”(Double Sided Lighting)选项处于启用状态时，

由负缩放引起的背面多边形可能会变为黑色。负缩放后应当反转法线。 

MAYA-14552 Maya 2013 将加载插件管理器中的隐藏目录 

在 Maya 2013 中，模块的子文件夹是递归解析的。在 Extension for Maya 2013 中，默认情况下 

Maya 不会搜索子文件夹。要在搜索中包含子文件夹，请在模块定义文件中使用 [r] 关键字为文件

夹请求递归行为；例如，如下所示： 

[r] scripts: ..\..\CommonFiles\scripts 

 

.folders（即，文件夹名称以“.”开头，也称为隐藏文件夹）会被忽略，即使 [r] 关键字已设置。该

文件夹未递归解析，也未添加到模块/脚本文件路径。 

MAYA-16196“对象排序”(Object Sorting)透明度的新算法 

Extension for Maya 2013 针对“对象排序”(Object Sorting)透明度选项（“渲染器 > Viewport 

2.0”(Renderer > Viewport 2.0)）使用了新算法，可以提供更精确的结果。若要还原为旧版 (Maya 

2013)“对象排序”(Object Sorting)算法，请设置 

MAYA_OBJECT_SORT_USING_BOUNDING_BOX = 1。 

MAYA-14871 操纵装备（父约束）时“顶点动画缓存”(Vertex Animation Cache)不会更新 

当 Viewport 2.0 中“顶点动画缓存”(Vertex Animation Cache)处于启用状态时，使用带有父约束的

角色动画装备可能会在调整装备时导致更新失败。 

解决方案：调整装备时禁用“顶点动画缓存”(Vertex Animation Cache)，然后在播放检查时重新启

用。 

 

 

 

 

 

Autodesk, Backburner, FBX, Maya, MotionBuilder, Mudbox, Softimage, and 3ds Max are registered trademarks or 

trademarks of Autodesk, Inc., and/or its subsidiaries and/or affiliates in the USA and/or other countries. All other 

brand names, product names, or trademarks belong to their respective holders. Autodesk reserves the right to alter 

product and services offerings, and specifications and pricing at any time without notice, and is not responsible for 

typographical or graphical errors that may appear in this document. 

 

©2012 Autodesk, Inc. All rights reserved. 
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